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 READ ME FIRST SYSTEM NOTES 

1. The file you are currently reading, SpsInstallationReadMeFirst.pdf, contains both 

installation and administrative information and should be read in its entirety before 

proceeding with application installation. 

2. All communication with SysPricer Corporation, hereinafter referred to as the 

Corporation, including obtaining Product activation keys, needs to be accomplished 

via Email at support@syspricer.com. 

3. In an Email requesting a Product activation key, the User needs to provide the 

following information: 

 ● Company/Corporation Name & Address 

 ● Point-of-Contact: 

  ● Name 

  ● Telephone Number 

  ● Email Address 

 ● Whether request is for a Trial or a Fully Licensed Product activation key 

  ● A Fully Licensed Product activation key requires pre-payment to the distributor. 
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 SECTIONS 

A. Installing and Activating the Products 

 1. Sps related files are installed on the user's computer by running an executable 

setup file (e.g., Setup_SpsPBLB.exe) that can be downloaded from the 
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Corporation’s web site (www.syspricer.com).  Executing the subject setup file 

overwrites any Sps application files that have already been installed on the user’s 

computer, including proof of a valid activation.  The subject setup file needs to 

be, and should be, run only once on any given computer.  Any future updates 

to Sps system files will be accomplished by the user downloading the updated 

files from the syspricer.com web site and replacing the corresponding existing 

files with them. 

  a. Before executing the application’s setup file, if the Sps application you plan to 

install (i.e., either Sps Proposal Builder Large Business or Sps Proposal 

Builder Small Business ) already resides on your computer as an activated 

application, you must Deactivate it and obtain a Deactivation Key as 

proof of Deactivation, as explained in Section H. Sps Proposal Builder 

Deactivation and Reactivation below.  If you have any questions about this 

subject, contact the Corporation before proceeding. 

  b. If you plan to install the MS Access Runtime version, an installation error can 

occur, if you try to install it and a version of it is already installed on your 

computer.  An existing MS Access Runtime application must be uninstalled 

before it can be re-installed successfully.  Removal of the installed Runtime 

version is accomplished by using the Add/Remove Programs routine that is 

part of the MS Windows Operating System.  The exact sequence depends on 

the MS Windows version installed on your computer.  You can download MS 

Access Runtime directly from Microsoft, as follows: 

    MS Access 2016 Runtime: 

    URL: https://www.microsoft.com/en-us/download/details.aspx?id=50040 

  c. During the installation process, shortcuts to run the Sps Proposal Builder can 

be added automatically to your computer's Start Menu and Desktop.  If not 

added during the installation process, you can use standard MS Windows 

conventions to add them later. 

  d. Relevant MS Access version information, as regards Sps requirements, is 

provided in the Microsoft Access and Microsoft Excel Version Notes section 

below.  If a Full/non-Runtime version of MS Access is installed on your 

computer, and you’re unsure of its version, you can verify it using MS Access 

Main Menu Bar → File → Account → About Access to display the version. 

  e. Both the Proposal Validation Model and Proposal Analyzer use Macros that 

must be enabled for them to work properly.  See the MS Excel Macro 

Security Considerations section below for guidance on how to handle Macro 

security issues. 

https://www.microsoft.com/en-us/download/details.aspx?id=50040
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    2. After Corporation products have been installed on a user's computer, they must be 

activated. 

  a. The System generates and displays a unique Control Number for the Proposal 

Builder Large Business and Proposal Builder Small Business the first time 

each is run.  Each Control Number has an Activation Key tailored specifically 

to it.  The Proposal Builder Data Entry Utility doesn’t use an Activation Key. 

  b. Record the applicable Control Number and contact the Corporation using one 

of the following contact methods to obtain the corresponding Activation Key: 

   (1) Email:  support@syspricer.com 

   (2) Telephone:  N/A 

    See the Product Support section below for information about the 

Corporation’s Product Support policy. 

  c. After obtaining the appropriate Activation Key, the System Administrator 

needs to record it for use in completing the activation process.  The Activation 

Key for the Proposal Builder SHOULD BE RETAINED INDEFINITELY, 

since it's needed to deactivate a Sps Proposal Builder application before it can 

be reactivated on another computer. 

  d. A dialog box showing the Control Number and requesting user entry of the 

Activation Key will be displayed each time a Proposal Builder application is 

run, until the user supplies the valid Activation Key. 

   (1) If the Trial version of the Proposal Builder is being used, a dialog box 

showing the number of days and runs remaining during the trial period will 

be displayed each time the Proposal Builder application is run.  The user is 

afforded the opportunity to enter the Activation Key for the licensed 

version, if it's available.  This dialog box continues to be displayed until 

either the licensed version of the product is activated or the trial period 

expires. 

 3. After the Proposal Builder has been activated, for each installation, the System 

Administrator can control individual user access to the various System menu 

items (i.e., operations) using PropOpen → UserAccess on the Proposal Builder's 

Main Menu.  Disabling selected operations and setting the UserAccess password 

can be used to control the proposal preparation process in a multi-user 

environment. 

B. System Components 

 1. The System consists of four separate components, a Proposal Builder Large 

Business, Proposal Builder Small Business, Proposal Builder Data Entry Utility 
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and Proposal Analyzer.  The Proposal Builder Data Entry Utility works only with 

proposals created and maintained by the Proposal Builder Large Business and 

Proposal Builder Small Business, and is limited to data entry into a Sps structured 

proposal.  Both Proposal Builders prepare files that are fully compliant with the 

applicable ANSI standards for a contract pricing proposal.  The Proposal Builder 

Large Business will handle the largest and most complex cost proposals, while the 

Proposal Builder Small Business provides an affordable alternative suitable for 

small business.  The Proposal Builders and Proposal Analyzer address different 

aspects of the proposal process and run independently of each other.  However, 

the Proposal Builder Large Business or Proposal Builder Small Business is needed 

to create the Excel Workbooks that the Proposal Analyzer uses as its data source.  

All Sps components are licensed, not sold.  The Proposal Builder Large Business 

and Proposal Builder Small Business are licensed separately and the license for 

each grants the buyer the right to install and use one copy of the subject 

component on a single computer.  In addition, the license for both Proposal 

Builders includes the right for the buyer to install, use and distribute unlimited 

copies of the separate, ancillary Proposal Builder Data Entry Utility designed to 

be used in conjunction with them.  The Proposal Analyzer is an ancillary utility 

that uses Excel Workbooks generated by the Sps Proposal Builders as its data 

source and is distributed with them. 

 2. The System has been designed to take advantage of the powerful features inherent 

in Microsoft Access and Microsoft Excel, both of which are part of the Microsoft 

Office Suite. 

  a. The Proposal Builder Large Business, Proposal Builder Small Business and 

Proposal Builder Data Entry Utility require that MS Access, either the full or 

runtime version, be installed on the user's computer.  The full version must be 

purchased separately, if not already purchased for general use.  The full 

version provides the user full use of the MS Access application (i.e., it can be 

used for purposes other than with the System's Proposal Builder applications).  

All Proposal Builder operations can be accomplished using either version.  

The full version offers significant, potential advantages to experienced Sps 

users who regularly work with very large proposals.  It can be used to develop 

custom interfaces that provide seamless integration of Sps and other existing, 

and future, user cost estimating and cost management systems.  The full 

version also allows the user to access proposal data tables directly without 

recourse to the Sps user interface.  This provides an opportunity to make bulk 

data changes much faster than by using the Sps User interface, but, on the 

down side, increases the possibility of entering invalid data by circumventing 

certain data validation processes built into Sps data entry forms. 
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  b. Both the Proposal Builder Large Business and Proposal Builder Small 

Business can generate an MS Excel Workbook that can be used for proposal 

validation purposes.  Sps uses the MS Excel xlsm file type (XML Macro-

Enabled), introduced in MS Office 2007, as its default file type.  The MS 

Excel Workbook generated by the Proposal Builders can also be used for real-

time sensitivity analysis and as the data source for the Proposal Analyzer. 

   (1) There is no runtime version of MS Excel that is suitable for Sps purposes.  

It must be purchased separately, if not already installed on the user's 

computer for general use. 

 3. The Proposal Builder Large Business will handle the largest and most complex 

cost proposals, while the Proposal Builder Small Business provides an affordable 

alternative suitable for small business. The Sps Proposal Builder Small Business 

(PBSB) includes all of the operational capabilities of the Sps Proposal Builder 

Large Business (PBLB), except for the following differences: 

  • The Cost Element table for PBSB, accessed using Menu sequence 

BuildStructure → Element, is limited to 160 table records.  Depending on an 

entity’s individual estimating system characteristics, 160 table records will 

translate into a Summary worksheet of 75-85 separate cost elements. An Excel 

workbook is available that shows an example of how 160 table records were 

used to build a Workbook that handles 84 separate cost elements, a number 

that should accommodate the vast majority of proposals prepared by small 

businesses. The subject workbook example can be opened and viewed via 

www.syspricer.com Website Link Sps PBSB Maximum Cost Element 

Example. 

  • The WBS table for PBSB, accessed using Menu sequence BuildStructure → 

WBS, is limited to 125 table records. 

  • The SOW table for PBSB, accessed using Menu sequence BuildStructure → 

SOW, is limited to 65 table records. 

C. Getting Started 

 1. Both the Proposal Builder and the Proposal Analyzer are designed to be easy to 

use.  Learning to use them is aided by the fact that most operations are intuitive.  

Also, Help for every System operation is available via custom System Help. 

 2. The new user is advised to begin by reviewing the topics under the Contents Tab 

of System Help. 

  a. System Help for the Proposal Builder is activated by selecting Menu Item 

Help from the application's main menu bar and then selecting Help System 

Overview from the drop-down list. 



6 
 

  b. System Help for the Proposal Analyzer is activated by selecting custom Menu 

Item Sps Menu Items → AppHelp from the application's main menu bar and 

then selecting Help System Overview from the drop-down list. 

 3. Topic By the Numbers in Book Using the System (under the Contents Tab of 

System Help for both the Proposal Builder and the Proposal Analyzer) provides 

hands-on experience using the System.  For many users, these exercises will be all 

that’s needed to prepare them to use the System for actual proposal preparation 

and analysis. 

 4. The System is distributed with several sample proposals. Their purpose is to 

provide the user with a hands-on method to become familiar with various System 

operations.  File Sps Sample Proposal Notes.pdf provides guidance on using these 

sample proposals to help understand proposal cost logic structure definition, a 

process the user may not find intuitive, but one that can be readily learned with a 

little practice. 

D. Microsoft Access and Microsoft Excel Version Notes 

 1. The Corporation’s Systems Pricing System (Sps) requires that both Microsoft 

Access and Microsoft Excel be installed on the user’s computer to take full 

advantage of the System.  A System generated ANSI compliant text file can be 

created using MS Access alone and a System generated Validation Workbook can 

be used by MS Excel alone, but using both applications together provides the user 

with more real-time functionality and flexibility. 

  2. All Sps Proposal Builder applications have been created and compiled using MS 

Access 2016, and MS Access 2016 (or higher) is required to run them.  All Sps 

Proposal Builder applications run the same on the MS Access 2016 Full Version 

and the MS Access 2016 Runtime Version. 

 3. The System uses MS Excel to generate and view Validation Workbooks and to 

run the Sps Proposal Analyzer.  MS Excel 2016 was used to create MS Excel 

related Workbooks and code, and this version (or higher) is the recommended 

version for Sps. 

E. MS Excel Macro Security Considerations 

 1. The System's Validation Models that are generated by its Proposal Builders and its 

Proposal Analyzer are MS Excel Workbooks, so Macro Security issues need to be 

considered.  After opening MS Excel 2016, for the Validation Model Workbooks 

and for the Proposal Analyzer Workbook, Macro-related security issues can be 

resolved by designating the folder(s) where the subject files reside as Trusted 

Locations using the following sequence: 
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  Menu Bar File [Tab] → Options → Trust Center → Trust Center Settings... → 

Trusted Locations → Add new location... → [Add applicable folders/subfolders 

and Save] 

 2. Neither the System's Proposal Analyzer nor its Validation Models support digital 

signatures. 

F. Operational Considerations 

 1. During certain Sps Proposal Builder operations (e.g., Validation Model creation 

and Import → Data), the message Systems Pricing System (Not Responding) may 

appear on the title bar at the top of the display.  A similar (Microsoft Excel - 

[Workbook Name] Not Responding) message may also appear while using an MS 

Excel Workbook created by Sps as a validation model.  This message is generated 

automatically by the MS Windows operating system, when a program fails to 

acknowledge a request from it within an expected timeframe.  This message 

DOES NOT necessarily indicate that the application has stopped working or that 

it has malfunctioned.  It clears automatically, when MS Windows receives the 

expected response from the application.  Because display of the subject message is 

a function of proposal size and complexity, CPU speed and other hardware 

characteristics, and the number and type of other processes running on the user's 

computer, it's impossible to predict if, or when, it may appear.  Since it's unlikely 

that the subject message indicates an actual Sps software malfunction, you are 

advised to wait until it clears automatically.  During testing by the developer on 

very large and complex proposals, when the message appeared, it usually took less 

than a minute to clear automatically.  If you should experience unacceptably long 

delays associated with the subject message, closing other non-essential processes 

running on your computer may help to resolve the problem.  Relief may also be 

gained by changing the Sps application's process priority by using the MS 

Windows Task Manager.  You could also try running the application on a faster 

computer. 

 2. As noted above, Sps uses the MS Excel xlsm file type (XML Macro-Enabled), 

introduced in MS Office 2007, as its default file type.  The subject file type has 

the following Worksheet capacities: 

  ● xlsm (MS Excel 2007 and later): 1,048,576 rows by 16,384 columns 

  Using the xlsm file type ensures that no proposal will exceed Worksheet limits. 

G. Upgrading from MS Access Runtime to MS Access Full Version 

 If after installing the Runtime version of MS Access, you subsequently upgrade to the 

Full version, you can run the Sps Proposal Builder application (with its accde file 



8 
 

extension) with no further action needed.  You DO NOT have to reinstall the Sps 

product. 

H. Sps Proposal Builder Deactivation and Reactivation 

 1. The Software License agreements for the Proposal Builder Large Business and 

Proposal Builder Small Business allow each application to be used on a single 

computer at any given time, so an application must be deactivated on one 

computer before it can be reinstalled, activated and used on another computer.  

After the application has been deactivated, it cannot be used until reinstalled and 

reactivated, so be sure of your intention before proceeding with the deactivation 

process.  A Deactivation Key, and associated Control Number, is displayed during 

the deactivation process for each application.  Be sure to record both the 

Deactivation Key and Control Number, as both are needed as proof of product 

deactivation. 

 2. The sequence of events for a typical product deactivation and reactivation is 

outlined, as follows: 

  a. Deactivate the application using the appropriate application menu item. 

  b. Record the Control Number and Deactivation Key displayed by the 

application during the deactivation process. 

  c. CHECK TO ENSURE YOU HAVE CORRECTLY RECORDED THE 

CONTROL NUMBER AND DEACTIVATION KEY DISPLAYED 

DURING THE DEACTIVATION PROCESS.  BOTH ARE NEEDED AS 

PROOF OF DEACTIVATION AND TO REINSTALL THE PRODUCT 

IN ACCORDANCE WITH THE TERMS OF THE PRODUCT'S 

LICENSE AGREEMENT. 

  d. Uninstall the application using the MS Windows Control Panel or, 

alternatively, delete the folder where the application resides. 

  e. Reinstall the application using the application setup file. 

  f. Record the Control Number displayed during the application installation 

process. 

  g. Contact the application distributor: 

   (1) Provide the Deactivation Key and Control Number for the deactivated 

application, as proof of product deactivation. 

   (2) Provide the Control Number for the newly installed application and obtain 

its Activation Key from the distributor. 

  f. Activate the newly installed application. 
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 3. Both the Proposal Builder Large Business and Proposal Builder Small Business 

include safeguards that allow the System Administrator to protect against 

unintended deactivation.  The Proposal Builder is installed with the DeActivate 

Menu Item disabled.  The System Administrator can prevent a user from enabling 

the subject menu item by assigning a password to UserAccess operations using the 

following menu item sequence: 

  [Main Menu] → PropOpen →UserAccess → Password → Set 

I. Copyright and Licensing Notes 

 1. SysPricer is a trademark of the Corporation.  The Proposal Builders Large 

Business, Small Business, Data Entry Utility and Proposal Analyzer are 

Corporation software products that together comprise the Corporation’s Systems 

Pricing System (Sps).   Copyright 2009-2024 SysPricer.  All rights reserved. 

  2. Microsoft and Windows, Access and Excel are either registered trademarks or 

trademarks of Microsoft Corporation.  Microsoft software needed to run the 

Corporation’s software products is distributed under license from Microsoft.  

Copyright 1992-2024 Microsoft.  All rights reserved. 

      3. License Agreement 

  a. The Corporation’s Software License Agreements, and the opportunity to 

either accept or decline the terms, are displayed during product installation and 

activation.  After successful product activation, they are viewable using Menu 

sequence Help → About Sps → Display License Agreement Button.  The user 

must accept the terms of the associated License Agreement before each 

product can be activated. 

  b. Activating the Software Product constitutes user acceptance of the License 

terms. 

J. Product Support 

 1. The following Product Support is included as part of product purchase: 

  a. The Corporation will take action to correct any deficiencies identified in the 

software that have a material effect upon product performance. 

  b. The Corporation will respond to questions about product usage as soon as 

possible, in the order in which the questions are received. 

  c. The Corporation will answer procedural questions about how to build 

Proposal Builder Logic Tables, but will not build them as part of Product 

Support. 
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 2. Contact Points are as follows: 

  a. Email:  support@syspricer.com 

  b. USPS Mail: SysPricer Corporation 

       6 Technology Drive, Unit 221 

       Chelmsford, MA 01863 

 3. Consulting and training services are available at additional charge, as agreed-to 

between the Corporation and individual users of the product. 

 


